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Web Tutorial 

Using this Web Tutorial and QuickBooks software, you will complete accounting procedures typical of many businesses. This guide can be used with Century 21 Accounting, 9E; Fundamentals of Accounting, 9E; and Century 21 Accounting, Advanced, 9E. You must read and understand the accounting concepts and procedures presented in your accounting textbook before completing problems using this guide and the QuickBooks software.
Using this Web file 

All students should read and follow the instructions in this Web Tutorial to prepare for completing the accounting problems. Your instructor will tell you which problems to complete.
Begin each problem by reading the problem objectives. These objectives state what you will accomplish by completing the problem. Follow the instructions provided for each problem to complete the accounting task using QuickBooks. Pay special attention to notes in the left margin, such as Accounting Tips and Check Figures, that will help you with your work.
QuickBooks uses four-digit account numbers by default. Some problems in the accounting textbook use three-digit account numbers. The account numbers in the problems have been changed to four digits where needed. 
In instances where the problem numbers differ between the General Journal and Multicolumn Journal versions of Century 21 Accounting, 9E, the difference is noted at the beginning of the problem. 
Pay special attention to using the correct date when completing problems. For some problems, you will use the current year in the date. In other problems, transactions have already been entered in the company data file using the QB year. You must use the QB year as the year for your entries to complete the related transactions correctly. Follow the directions regarding dates in each problem.
QuickBooks is designed to be used by a company to keep records on a continuing basis. As you use QuickBooks, the software will sometimes display dialog boxes that ask whether you wish to change some setting to customize the software for your company. Customizing the software would be helpful if you were to use only one or two companies for the problems you complete. However, because each problem uses a different company, you need not customize the software. When one of these boxes appears, close the box without making the suggested change.
Organizing Data Files 
Data files are provided for use in completing the problems in this guide. Each file includes the beginning data shown in the Working Papers for the problem. Before you begin working problems, you must copy the data files to a working folder.
Create a Working Folder 

You must copy the data files to a working folder on a hard disk or a network drive so the files can be opened. Your instructor will tell you where to create your working folder for the files.
The steps that follow provide instruction on how to create a working folder on a hard drive or floppy disk using the Windows Explorer program. Your instructor will need to provide additional guidance if you are directed to create a folder on a network drive. Follow the steps below to create your working folder.
1.
To start Windows Explorer, click the Start button. Point to (All) Programs (then to Accessories if you have Windows 2000 or XP), and then click Windows Explorer.

2.
In the left pane of Windows Explorer, click the name of the folder in which you have been directed to create your working folder. (If the folders do not display in the left pane, click the Folders button on the toolbar.) 
3.
Choose New from the File menu and then choose Folder. A new folder named New Folder will appear in the window. In the right pane, the name will be highlighted.

4. 
Key a name for the folder as directed by your instructor. For example, you might name the folder Student Name QB using your name and QB for QuickBooks. Tap Enter.

5.
Note the name and location of your working folder so you can navigate to it easily when needed.
Copy Data Files 
After you have created your working folder, copy the data files from the location specified by your instructor. The steps that follow tell how to copy files using the Windows Explorer program. Your instructor may need to provide additional information if you are directed to copy files to a network drive.

1.
Open the folder that contains the data files. 
2.
Select the files to be copied. (You can select multiple files by holding down the Ctrl key as you click each filename.)

3.
Choose Copy from the Edit menu.

4.
Open your working folder. Choose Paste from the Edit menu.

Rename Data Files 
After you have copied the data files to your working folder, rename each file using a unique name. This will help identify your files and reduce the chances of accidentally overwriting a classmate’s work. Instructions are given in the first problem on how to add your name and the problem number to a footer on the reports you print. This will further identify your work.

Your instructor will tell you what changes you should make to the filenames. You may be asked to add your initials or a code number to the filenames. For example, you might change O’Kalla Lawn and Garden.qbw to O’Kalla Lawn and Garden XX.qbw where XX is your initials. Change only the filename, not the qbw extension. (Depending on the setting selected in Microsoft Windows, the filename extension .qbw may or may not display.)

If a company name is reused in a later problem and the problem does not reuse your earlier file, the data file name will include the chapter number (for example: C4 O’Kalla Lawn and Garden.qbw).
The steps that follow tell how to rename a file on a hard drive or floppy disk using the Windows Explorer program. Instructions may differ slightly depending on the version of Microsoft Windows you are using. Your instructor may need to provide additional guidance if you are directed to rename files on a network drive. 
1.
In Windows Explorer, click your working folder to open it. 

2.
Click the filename you wish to change. 
3.
Choose Rename from the File menu. Key the new filename and tap Enter.
QuickBooks Basics 
You will use some basic software features or procedures with most problems you complete. Instructions for these basic software features are included here in the Web Tutorial. Read and follow the instructions in the sections that follow to start QuickBooks, open a company file, close a company file, use QuickBooks Help, and exit QuickBooks. Refer to these sections later as you complete the problems, if needed, to review the procedures. All amounts used in the examples will be from the first problem that uses the software feature.
Start QuickBooks 
To start QuickBooks using Microsoft Windows XP: 

1.
Click on the Start button on the Task Bar. Choose All Programs from the Start menu.
2.
Choose QuickBooks from the Program menu. Click on QuickBooks 9 from the menu.
Figure 1 QuickBooks on the Programs Menu 
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3.
The software will open and show the No Company Open dialog box. 

Figure 2 No Company Open Dialog Box 
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Open a Company File 
When you start QuickBooks, the No Company Open box will appear. You can open a company file from this window. If you have already been using QuickBooks and want to open a different company file, you can do so using the File menu.
1.
Start QuickBooks if it is not already open. Click the Open an existing company button in the No Company Open box, or choose Open Company from the File menu. The Open a Company dialog box will appear. Click the radio button next to Open a company file and click Next.
2.
Click the arrow for the Look in box and browse to find your working folder. Select your working folder.
Figure 3 Open a Company Dialog Box 
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3.
Click the name of the file you want to open such as AllSport Center-09.QBW. (Depending on the setting selected in Microsoft Windows, the filename extension .QBW may or may not display.)
4.
When the filename shows in the File name box, click Open. 
5.
The Company Navigator screen will appear as shown in Figure 4. You can perform many tasks from this screen. If the entire Company Navigator screen is not displayed in the window, use the vertical and horizontal scroll bars to view the other parts of the window.
Figure 4 QuickBooks Main Screen 
[image: image4.png]File Edit View Lists Company Customers Vendors Employees Banking Reports Online Services Window Help

& =]
Company Snapshot _Customer Center Vendor Center _Employee Center

@ E4 H @
Online Banking Report Center | | Help

[c]
invice

EY

B vendors

£
<

& Employees

—_—

Enter il PayBils

Create Sales
Recepts.

Company

Chartof
Accounts

Items &
Services

=)

Intut.com
Services

nking

B
4
Receive
Payments

Estinates.

Statement
Charges

&

Statements.

i

Learn about
Payrol Optons

Refunds
&Credts

Recondle

2

Check.
Regster

@5 Accent aeditcards
& Order Chedks & Business Cards:

¥ GetMore Customers:

El Reminders & Alerts

B View Reminders





6.
You can also use the program’s menu bar and ribbon to choose commands you will need to work with the open company file. To give a command using the ribbon, simply click a button. To use the menu bar, click an option on the menu bar, such as Reports. Choose an option from the drop-down list, such as Company & Financial. Some of the options on the drop-down lists have an arrow on the right side as shown in Figure 5. The arrow indicates that additional choices are available under these options. For example, several reports are listed under the Company & Financial option. Take some time to view the main options offered for each item on the menu bar. 
Figure 5 Report Drop-Down Menu 
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Access QuickBooks Help 

Each time you need to use a new feature or procedure in QuickBooks to complete a problem, instructions are provided. However, you may also want to use the QuickBooks Help feature to learn about or review software features. Follow the steps below to use QuickBooks Help.

1.
Choose QuickBooks Help from the Help menu as shown in Figure 6.
Figure 6 QuickBooks Help Drop Down Menu
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2.
Click the Search tab. Enter a search word or term the in text box as shown in Figure 7 and click the arrow button. A list of Help entries related to the search term will appear.
Figure 7 QuickBooks Help Window 
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3.
Choose an entry from the list and click it. Read the Help information in the lower pane of the window. Click the Close control button for the window to close Help.

Close a Company File 
When you start QuickBooks, the last open company file may still be open. To prevent this, you should close each company file when you are finished working with it. Closing your company files will keep another student from accidentally changing or using your work.

To close a company file, choose Close Company from the File menu. You can now exit QuickBooks or let another student use the computer.
Figure 8 File Menu 
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Exit QuickBooks 
Your instructor may ask you to turn off your computer when you finish a problem or at the end of the class period. You should exit QuickBooks before turning off your computer.
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To exit QuickBooks, choose Exit from the File menu. You are now ready to close Windows and turn off your computer.

Journalize Transactions 

1.
Choose Make General Journal Entries from the Company menu. The Make General Journal Entries window will appear.

Figure 9 Make General Journal Entries Window
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2.
Enter the date of the first transaction in the Date box. You can also change a date by using the calendar button as explained in the Software Tip at the left. 

3.
Key the transaction as shown in Figure 9. Click in the Account field. Click the down arrow in the Account field. Choose the correct account from the drop-down box. Tap Tab to move to the appropriate field and enter the debit amount. Key the appropriate information (R1) in the Memo field. Choose the correct account and enter the amount for the credit part of the transaction. Key the appropriate information (R1) in the Memo field.

4.
Click the Save & New button to save the transaction. A blank Make General Journal Entries screen will appear. 

5.
Enter the remaining transactions. Use a new blank Make General Journal Entries window for each transaction. Be sure to enter the correct date for each transaction. For purchases or sales on account, use the drop-down list in the Name field to choose the proper Accounts Payable vendor or Accounts Receivable customer. 

6.
Click the Save & Close button when you finish keying the transactions for November.

Note: You can check previous transactions by clicking the Previous button until the transaction you want shows on the screen. If no changes need to be made, click the Next button until you find the next blank entry. If changes are needed, key the changes, click the Save & New button, and click Yes to record the changes. Then click the Next button until you find the next blank entry. 

If you need to end your session before all of the transactions have been keyed, click the Save & Close button and close your company as shown on page 8 of the Web Tutorial. You can continue keying the transactions in your next session.

Print a Journal 

One of the reports you should always review after making journal entries is the General Journal or Journal. This report contains all of the data you keyed in the Making General Journal Entries screen. Use the following steps to print a Journal.
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1.
Choose Accountant & Taxes option from the Reports drop-down menu. Choose Journal. The Journal window will appear. 

2.
Change the From date to November 1, (Year). Change the To date to November 30, 2(year) (or the date used in the problem). Click the Refresh button so the data for the date range you selected shows in the report as shown in Figure 10. Always double check the dates used for reports. Incorrect dates or date ranges can cause reports to show incorrect data even if all transactions were keyed correctly.

Figure 10 Journal Report Window 

[image: image10.png]ody Report... ] _| Memonge... ] Pr... ) Exmad v ) Expot... _| ride regder ] _[ refregh )

Dates | Custom | From | 11/01/2009 (8] To |11/30/2009 [E] Sort By | Default v
B O'Kalla Lawn and Garden
oatio Journal
November 2009
Trans#c  Tyse o Date otum o Wame o Memo o Accout o Debit o credt
> 1 Goveraldoural | TmIZOS 1 & 00 Cash, 550000
R 3100- Petrick O, ss0m0

550000 550000





3.
Review the report to make sure all transactions are shown correctly. (If corrections are needed, open the Make General Journal Entries window and make them. Then go back to the report.)

4.
All of the data may not display in the columns of the report. To display all of the data, widen the columns. Place the cursor on the small diamond to the right of the column heading. When the cursor changes to a double-headed arrow, drag the column to the right until all contents are visible.

5.
Add a custom footer that includes your name and the problem number. Click the Modify Report button found at the top left of the Journal window. Choose the Header/Footer tab in the Modify Report: Journal dialog box.

6.
Key your name and the problem number (such as 4-5 Mastery Problem) in the Extra Footer Line text box. All three options should be checked as shown in Figure 11. Click OK to save the footer.

Figure 11 Extra Footer Information Box 
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7.
Click the Print button at the top of the Journal window. The Print Reports dialog box will appear.

Figure 12 Print Reports Dialog Box 
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8.
Select the printer you wish to use. Click the Landscape radio button in the Orientation section. Make sure there is not a check mark in the box next to Fit report to. This will ensure that the Journal report will preview and print at full size. 

9.
Click the Preview button to view the report. Make sure your custom footer shows at the bottom of the report. Click the Close button on the Print Preview window. (If needed, close the Print Reports dialog box and make changes. Then access the box again.)

10
Click the Print button in the Print Reports dialog box. The Journal report should print in landscape mode. Click the Close button on the Journal window to close the report.

Print a Balance Sheet 

1.
Choose Company & Financial from the Reports drop-down menu. Choose Balance Sheet Standard as shown in Figure 13.

Figure 13 Choose Balance Sheet Standard Report 
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2.
Change the As of date to November 30, (year) (or the date used in the problem). Click the Refresh button so the data for the date range you selected shows in the report. The top portion of the report is shown in Figure 14.

Figure 14 Balance Sheet Report 
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3.
Review the report to make sure all balances are correct. Make corrections if needed. 

4.
Click the Modify Report button and choose the Header/Footer tab in the Modify Report: Balance Sheet dialog box.

5.
Key your name and the problem number (4-5 Mastery Problem) in the Extra Footer Line text box. Click OK to save the footer.

6.
Click the Print button. The Print Report dialog box will appear.

7.
Select the printer you wish to use. Click the Portrait radio button in the Orientation section. Make sure there is not a check mark in the box next to Fit report to. This will ensure that the report will preview and print at full size. 

8.
Click the Preview button to view the report. Make sure your custom footer shows at the bottom of the report. Click the Close button on the Print Preview window. (If needed, close the Print Reports dialog box and make changes. Then access the box again.)

9.
Click the Print button in the Print Reports dialog box. The report should print in portrait mode.

10. Click the Close button on the report window to close the report.

Prepare a Bank Reconciliation 

QuickBooks pulls information from the General ledger to help you prepare a bank reconciliation. The purpose of the reconciliation is to provide data to make any journal entries needed to make the general ledger cash balance match the bank balance. The company does not use the QuickBooks Write Checks feature. Information about checks can only be found in the Memo field of the Journal.

1.
Choose Reconcile from the Banking menu. The Begin Reconciliation dialog box will appear similar to the one shown in Figure 15.

2.
Make sure Cash shows in the Account field. Set the statement date to 8/31/2009. 

3.
Key the balance from the bank statement ($2,721.00) in the Ending Balance box. There was no beginning general ledger balance for Cash in this problem. Since there is a general ledger balance for Cash as of 7/31/YYYYQuickBooks pulls it into the Beginning Balance field.

4.
Key 15.00 in the Service Charge box. Use the bank statement date (8/28/2009) in the Date box. Choose Miscellaneous Expense from the drop-down menu under Account for the service charge. Leave the Interest Earned section blank 

5.
Your Begin Reconciliation dialog box should look like Figure 15. After making any needed corrections, click the Continue button.

Figure 15 Begin Reconciliation Dialog Box 
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6.
The Reconcile - Cash window will appear similar to Figure 16. All debits and credits to Cash will show in the appropriate columns.

7.
Review the transactions in the Checks, Payments and Service Charges section. Click in the blank field next to the Date field to place a check mark next to all transactions except 7 and 8. Transactions 7 and 8 are for check numbers 114 and 115 respectively. According to the problem detail above, these checks are outstanding.

8.
Review the transactions in the Deposits and Other Credits section. Click in the blank field next to the Date field to place a check mark next to all transactions except 9. Transaction 9 is for the 8/31 sales tape. According to the problem detail above, this deposit did not show on the bank statement.

9.
Your Reconcile - Cash dialog box should look like Figure 16. Make sure that the amount next to Difference (lower right) is 0.00. After making any needed corrections, click the Reconcile Now button.

Figure 16 Reconcile - Cash Dialog Box 
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10.
The Select Reconciliation Report dialog box will appear as shown in Figure 17. Choose the Both option to create the Summary and Detail reports. Click the Display button to open the reports window.

Figure 17 Select Reconciliation Report Dialog Box 
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11.
The Reconciliation Summary report will show first. Add an extra line footer to include your name and the problem number. Print the report in portrait orientation. 

12.
Close the Reconciliation Summary report window. The Reconciliation Detail report will appear. Add an extra line footer to include your name and the problem number. Print the report in portrait orientation. Close the report window.

Journalize Service Charge Transaction 

You do not need to enter a journal transaction for the $15.00 bank service charge. QuickBooks automatically makes this journal entry. The entry is based on the information you enter for Service Charges in the Begin Reconciliation dialog box.

If you enter data for interest in the Begin Reconciliation dialog box, QuickBooks will automatically make the related journal entry for this account also.

Access Previous Reconciliations 

If you close one of the reconciliation reports in error or simply need to access it at a later date, you can reopen the report.

1.
Choose Banking from the Reports menu. Choose Previous Reconciliation. The Select Previous Reconciliation Report dialog box will appear as in Figure 18.

Figure 18 Select Previous Reconciliation Report Dialog Box 
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2.
Make sure Cash shows in the Account box. Click the appropriate radio button under Type of Report to open one or both reports.
3.
Choose the second option under In this report, include. Click the Display button. The report(s) you selected will display in the window.

Print a Profit & Loss Report 

1.
From the Reports menu, choose Company & Financial. Choose Profit & Loss Standard as shown in Figure 19. 

Figure 19 Choose Profit & Loss Standard Report 
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2.
Select April 1 and April 30, YYYY, for the From and To dates. Click the Refresh button. 

3.
Click the Modify Report button and choose the Header/Footer tab. Key your name and the problem number in the Extra Footer Line text box. Click OK to save the footer.

4.
Click the Print button in the Profit & Loss window. Select the printer you wish to use in the Print Reports dialog box. Select portrait orientation and click the Print button.

5.
Click the Close button in the Profit & Loss window to close the report.

Modify a Profit & Loss Report 

The company data file for Rolstad Repair Service contains all activity for the month ended September 30, YYYY. Use the data to prepare a Profit & Loss report that includes component percentages for expenses and net loss.

1.
From the Reports menu, choose Company & Financial. Choose Profit & Loss Standard. Select September 1 and September 30, 2009, for the From and To dates. Click the Refresh button.

2
To add component percentages, click the Modify Report button. The Modify Report: Profit & Loss dialog box will appear. In the Columns section on the Display tab, click the box next to % of Income. A check should appear in the box as shown in Figure 20. 
Figure 20 Modify Report Display Tab 

[image: image20.png]Modify Report: Profit & Loss

Display Fiters Header/Focter | Fonts &Numbers
Report Date Range
Dates [Custom ] The date range you specify in the From and To filds

From (0970172009 (]| To [09/30/2009 (]

Report Basis

@ncedl O cash This setting determines how this report caculates income and expenses.
Columns
Display columns by [Total oy Jacross the top, Sort by [Default v

@ hscendng order &4

# O Descending order 54

dd subcolumns for

[lereviousperiod [ Previous Year [ vear-ToDate  [] % of Row 1% of Calumn

oo e (% o Experse





3.
Click the Header/Footer tab. Enter an extra line footer that includes your name and the problem number. Click OK to close the dialog box.

4.
Print the Profit & Loss report in portrait orientation. 

Print a Trial Balance Report 
1.
Choose Accountant & Taxes from the Reports menu. Choose Trial Balance. 
2.
Enter October 31, YYYY, for the From and To dates. Click the Refresh button. 

3.
Click the Modify Report button. Click the Display tab. Click the Advanced button. The Advanced Options dialog box should appear. Under Display Rows, click the Non-zero radio button. Active should be selected under Display Columns. Fiscal Year should be selected under Reporting Calendar. Click OK to close the box.

4.
Click the Header/Footer tab. Enter your name and the problem number in the Extra Footer Line box. Click OK to close the dialog box.

5.
Click the Print button. Select the printer you wish to use in the Print Reports dialog box. Select Portrait orientation and click the Print button.

6.
Click the Close button to close the report.

Make Closing Entries in QuickBooks 
QuickBooks, like many PC-based accounting packages, automatically zeros out all income and expense accounts at the end of each fiscal period. The default fiscal year in QuickBooks is the calendar year. For companies that use a fiscal year other than the calendar year, the system administrator will typically make the needed changes to QuickBooks.
In QuickBooks, it is necessary to make some closing entries. You need to close Income Summary to the owner’s capital account for the amount of the net income or loss. For a net income, debit Income Summary and credit the owner’s capital account. For a net loss, debit the owner’s capital account and credit Income Summary. You also must close the owner’s drawing account to the owner’s capital account. To do so, debit the owner’s capital account and credit the owner’s drawing account. 

Print a Post-Closing Trial Balance Report 

A Post-Closing Trial Balance is created to check the beginning balances after all closing entries for the prior fiscal period have been made. In QuickBooks, the report should use the first day of the new fiscal period for both the From and To dates.

1.
Choose Accountant & Taxes from the Reports menu. Choose Trial Balance. Use November 1, YYYY, for the From and To dates. Click the Refresh button. 

2.
Click the Modify Report button. Choose the Header/Footer tab. Change the report title in the Show Header Information section to be Post-Closing Trial Balance as shown in Figure 21.

Figure 21 Modify Report, Show Header Information Section 
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3.
Choose the Display tab. Click the Advanced button. The Advanced Options box will appear. Click the Non-zero radio button in the Display Rows section as shown in Figure 22. The report will now display only rows with non-zero balances. Click OK to close the Advanced Options box.

Figure 22 Modify Report, Advanced Options Box
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4.
Click the Header/Footer tab. Enter an extra footer line that includes your name and the problem number. Click OK.

5.
Click the Print button in the Trial Balance window. Choose portrait orientation and click the Print button. Close the Close button to close the window.

Enter Bills 

In previous problems, you have entered transactions using the Make General Journal Entries window. For many transactions, you will continue to use the same process. For other transactions that involve purchases and payments on account, you will use the Enter Bills and Pay Bills features of QuickBooks to enter the transactions. By using these features, you can track purchases and payments on account. For example, you can easily see a list of bills that are due on a certain date. 


Use the Enter Bills option from the Vendors menu to enter all purchases on account. When you use this feature, the vendor’s Accounts Payable account is credited. You select the account to be debited in the Account field in the window.

To learn to use this feature, review the steps below to enter a July 2, YYYY, transaction. (Purchased merchandise on account from Woodland Computers, $2,600.00, P354) 
1.
From the Vendors menu, choose Enter Bills. 

Figure 23 Vendors Menu 
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2. The Enter Bills window will appear as shown in Figure 24. Make sure the Bill and the Bill Received options are selected.

Figure 24 Enter Bills Window 
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3.
Click the down arrow for Vendor. Choose Woodland Computers from the Vendor drop-down list. 

4.
Enter or select July 2, YYYY, in the Date field. The Bill Due date is calculated by QuickBooks. 

5.
Key 2,600.00 in the Amount Due field and P354 in the Ref. No. field.

6.
Leave the Terms field blank. The terms (payment terms) are set in the QuickBooks Preferences. (When needed, you can override the standard terms by choosing from the drop-down list for Terms. You will learn more about payment terms in later problems.) 

7.
Click in the Account field. Click the down arrow for the Account field. Select Purchases from the drop-down list in the Account field. The Amount is filled in by QuickBooks from the Amount Due field in the Bill section of the window. Key P354 (the purchase invoice number) in the Memo field.

8
Review the transaction. When everything is correct, click the Save & New button (lower right corner of the Enter Bills window) to save the transaction. 

9.
Repeat the process for all remaining purchases on account. When you have keyed all of the purchases on account transactions, close the window by clicking the Save and Close button (lower right corner of the Enter Bills window).

Pay Bills 

Use the Pay Bills option from the Vendors menu to make all payments on account. When you use this feature, the vendor’s Accounts Payable account is debited. Cash is credited. 

To learn to use this feature, review the steps below to enter a transaction. (July 4 Paid cash on account to Pacific Industries, $1,400.00, covering P351, less 2% discount. C242) 

1.
From the Vendors menu, choose Pay Bills. The Pay Bills window will appear as shown in Figure 25. 

Figure 25 Pay Bills Window 
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2.
Select the Show all bills option. To refresh the screen, click anywhere in the section of the screen that shows the bills to be selected. 

3.
To select a bill for payment, click in the field to the left of the Date Due field. A check mark will appear in the field showing that you have selected the bill for payment. Select for payment the bill with the Disc. Date of July 4.

4.
Click the Set Discount button. The Discounts and Credits box should appear as shown in Figure 26.

Figure 26 Discounts and Credits Box 
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If the Amount of Discount field is correct, click Done to accept the discount.


5.
Click the down arrow for Payment Account. Choose Cash from the Payment Account drop-down list. 

6.
Click the down arrow for Payment Method. Choose Check from the Payment Method drop-down list. Use July 4, YYYY, in the Payment Date field. 
7. 
Select the Assign check no. option. (The Assign Check No. option is used when checks will be written by hand. The To be printed option is used when checks will be printed later using QuickBooks.)

8.
Review the transaction. When everything is correct, click the Pay & New button (lower right corner of the Pay Bills window). The Assign Check Numbers window will appear as shown in Figure 27.

 Figure 27 Assign Check Numbers Window 
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8.
Select the option Assign the appropriate check number next to each bill payment check if it is not already selected. Key 242 in the Check No. field. Click OK to close the window and save the transaction. The bill will no longer show in the Pay Bills window.

9.
Repeat the process for all remaining payments on account. When you have entered all of the payment on account transactions, close the window by clicking the Pay and Close button (lower right corner of the Pay Bills window).

Enter Vendor Returns
Vendor returns can be processed easily in QuickBooks. To process a return to a vendor for an invoice that has not yet been paid, use the Enter Bills window as shown in Figure 28. When entering vendor returns, the vendor’s Accounts Payable account is debited for the amount of the return. You choose the account to be credited in the Account field (such as Purchases Returns and Allowances).

To learn this process, review the steps below for completing a transaction.

Figure 28 Vendor Return 
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1.
Choose Enter Bills from the Vendors menu. Click the Previous button until you find the purchase invoice you want to credit (July 6 transaction). 

2.
Click on the second line of the Expenses field. Click the down arrow and choose Purchases Returns and Allow. from the Account drop-down list, as shown in Figure 29. 
Figure 29 Account Drop-Down List 
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3.
 Enter the return amount (-1,640.00) in the Amount field. Enter the source document number (DM25) in the Memo field. Change the Amount Due to the revised amount ($920.00).

4.
Click the Save & New button to save the transaction. 

View Unpaid Bills Report 

1.
Choose Vendors & Payables from the Reports menu. Choose Unpaid Bills Detail as shown in Figure 30.
Figure 30 Unpaid Bills Detail Option 
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2.
Select or enter the date, July 31, YYYY. Click the Refresh button. The report will show all unpaid bills that have been entered as of that date. Change column widths as needed to display all of the data. Add a custom footer to the Unpaid Bills Detail report that includes your name and the problem number. Print the report in portrait orientation.

3.
Click the Close button to close the report window.

Receive Payments 

Use the Receive Payments option from the Customers menu to record payments on account. When you use this feature to record payments, Cash is debited for the amount of the payment. The customer’s receivable account is credited for the full amount of the invoice. If there is a sales discount, Sales Discount is debited for the discount amount.

To learn to use this feature, review the steps below to enter a transaction. (October 26  Received cash on account from Slumber Inns, covering S435 $1,356.00, less a 2% discount. R293.).

1.
From the Customers menu, choose Receive Payments. The Receive Payments window will appear as shown in Figure 31. A Merchant Account Service Message box may appear. If so, click the Close button in the upper right corner to close the window and continue.

Figure 31 Receive Payments Window
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2.
In the Customer Payment section, choose Slumber Inns from the Received From drop-down list. Enter a date (October 26, YYYY) in the Date field. The Customer Balance will be 1,356.00. Cash, the QuickBooks customer default, shows in the Pmt. Method field. 

3.
Key 1,328.88 in the Amount field ($1,356.00 less the 2% discount). A check mark will appear to the left of the invoice. An underpayment warning will appear in the lower left corner of the Receive Payment window as shown in Figure 32.


Figure 32 Underpayment Warning Box 
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4.
Click the Leave as an underpayment radio button. Click the Discount & Credits button. The Discount and Credits dialog box should appear as in Figure 33.

Figure 33 Discount and Credits Dialog Box 
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Make sure that the Amount of Discount is correct. Choose Sales Discount from the drop-down list in the Discount Account field. Click Done to apply the discount. The underpayment warning box should be gone.

4.
Key S435 in the Memo field. Key R293 in the Reference # field. Select Cash from the drop-down list in the Deposit to field. 

5
Review the transaction. When everything is correct, click the Save & New button (lower right corner of the Receive Payments window) to save the transaction. 

6.
Repeat the process for all remaining customer receipts on account. When you have entered all of the receipt on account transactions, close the window by clicking the Save and Close button (lower right corner of the Receive Payments window).
Apply Credits 

When a customer is paying an invoice for which partial credit was received, use the Discount & Credits option on the Receive Payments window to process the transaction. Review the steps below to record a transaction.
(June 9 Received cash on account from Joe Ricardo for eight chairs and a table purchased on S152 for $892.50 ($420.00 for the chairs and $472.50 for the table) less CM42 for two chairs ($100.00 plus $5.00 sales tax), less discount. R116.)

1.
Choose Receive Payments from the Customers menu. The Receive Payments window will appear. 

2.
Select the customer Joe Ricardo from the Received From drop-down list. Enter June 9, YYYY for the transaction date. 

3.
Enter 771.75 in the Amount field ($892.50 minus CM42 minus the 2% discount). Enter R116 in the Reference # field. Enter S152 in the Memo field.

4.
Place a check mark in the first column of the row for the invoice being paid (number 152). An underpayment warning box will appear in the lower left corner of the window. Disregard the warning. Click the Discounts & Credits button. Click the Credits tab. The Discount and Credits window will appear as shown in Figure 34.

5.
Place a check mark by the credit you wish to apply (number 42). If this were the end of the transaction, you would click the Done button. Because you still need to apply the 2 percent discount, click the Discount tab.

6.
QuickBooks will only allow one sales discount account for each customer receipt. Because you can only use one discount account for this transaction, Choose Sales Discount--Tables in the Discount Account field. You will need to use the Make General Journal Entries Window to transfer the amount of Sales Discount—Chairs to the correct account.

7. 
In the Amount of Discount box, QuickBooks suggests $17.85 for the discount. However, this discount amount is not correct because it is based on the total amount of the original invoice $892.50. You must manually calculate the amount of the discount for S152 minus CM42 ($892.50-$105.00=$787.50). Key 15.75 in the Amount of Discount field. Click Done.

Figure 34 Discount and Credits Window, Credits Tab 
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8.
Select the Deposit To option and choose Cash from the list. Click the Save & New button to record the transaction. 

Create Invoices 

Use the Create Invoices option from the Customers menu to record sales on account. When you use this feature, the customer’s accounts receivable account is debited for the total amount of the invoice. Sales is credited for the merchandise amounts. Sales Tax Payable is credited for the sales tax amount. 

To learn to use this feature, review a transaction. (October 27 Sold merchandise on account to County Hospital, $489.50, plus sales tax, $19.58; total, $509.08. S443.) 

1.
From the Customers menu, choose Create Invoices. The Create Invoices window will appear as shown in Figure 35.

Figure 35 Create Invoices Window 
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2.
Choose County Hospital from the Customer Job drop-down list. Choose Intuit Product Invoice from the Template drop-down list. Use October 27, 2009 in the Date field. Key 443 in the Invoice # field. The Bill To, Ship to, Terms, Ship, Via, and F.O.B. fields are filled in by QuickBooks. 

3.
Click in the Item Code field. Choose Merchandise from the drop-down list. Key the amount (489.50) in the Price Each field. QuickBooks automatically calculates the sales tax (4% on the bottom of the invoice. This happens because of the sales tax preferences that have been set in this company data file. (In a typical company, these preferences are set by the system administrator.)

4
Review the transaction. When everything is correct, click the Save & New button (lower right corner of the Create Invoices window) to save the transaction. 

5.
Repeat the process for all remaining sales on account. When you have keyed all of the sales on account transactions, close the window by clicking the Save and Close button (lower right corner of the Create Invoices window).

Enter Sales Receipts

When you use the Enter Sales Receipts window to record cash and credit card sales, Sales is credited for the amount of the cash and credit card sales. Sales Tax Payable is credited for the amount of the sales tax. Cash is debited for the total of the sales receipt. 
To learn to use the Enter Sales Receipts feature, 27.12review the steps below to enter a transaction. (October 28 Recorded cash and credit card sales, $3,165.00 taxable, $1,150.00 nontaxable, plus sales tax, of $126.60; total $4,441.60. TS44.).
1.
From the Customer menu, choose Enter Sales Receipts. The Enter Sales Receipts window will appear as shown in Figure 36. Select No when asked if you would like help in choosing the right sales form.

Figure 36 Enter Sales Receipts Window 
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2.
Enter October 28, YYYY in the Date field. Enter the terminal summary number, TS44, in the Sale No. field. 

3.
Click in the Item field on the first line. Select Taxable Sale from the drop-down list. Enter 3,165.00 on the first line in the Rate field. The number appears automatically in the Amount field. QuickBooks automatically calculates the sales tax.

4.
Click in the Item field on the second line. Select Nontaxable Sale from the drop-down list. Enter 1,150.00 on the first line in the Rate field. The number appears automatically in the Amount field. QuickBooks does not calculate sales tax for this amount.

5.
Select Cash from the Deposit To list.

6.
Leave the Customer: Job, Sold To, Check No, Payment Method, and Customer Tax Code fields blank.

7.
Review the transaction. Make changes if needed. Click the Save & New button (lower right corner of the Enter Sales Receipts window) to save the transaction. 

8.
Repeat the process for all remaining cash and credit card sales transactions. When you have entered the last cash sales receipt transaction, close the window by clicking the Save & Close button (in the lower right corner of the Enter Sales Receipts window).

Create Credit Memos 

Businesses create credit memos for customer returns. The Create Credit Memos/Refunds feature of QuickBooks can be used to credit sales invoices. When the Create Credit Memos/Refunds feature is used to journalize a customer return, Return should be used in the Item field so Sales Returns and Allowances is debited. The customer’s Accounts Receivable account is credited.

To learn to record customer returns, review the steps below to record a transaction. (October 29 Granted credit to Slumber Inns for merchandise returned, $124.00, plus sales tax, $4.96, from S435; total, $128.96. CM54.)
1.
Choose Create Credit Memos/Refunds from the Customers menu. The Create Credit Memos/Refunds window will appear as in Figure 37.

Figure 37 Create Credit Memos/Refunds Window 
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2.
Choose Slumber Inns from the Customer Job drop-down list. Choose October 29, YYYY for the date. Enter the memo number (54) in the Credit No. field. Enter the original invoice number (435) in the P.O. No. field.

3.
Click in the Item field. Click the arrow and choose Return from the drop-down list. Key the amount (124.00) in the Rate field. Click in the Amount field. The sales tax amount will be calculated automatically.

4.
Review the transaction. Click the Save & New button to save the transaction.

5.
The Available Credit dialog box should appear as shown in Figure 38 below.

Figure 38 Available Credit Dialog Box 

[image: image38.png]H Available Credit

You have just saved a credit memo/refund with an available
credit balance.,

What would you like to do with this credit?

() Give a refund
() Apply to an invoice

[ ] Don't show me this again

| ok






When the sales invoice (S435) to which the credit applies has been paid, select the radio button next to Retain as an available credit. Click OK to close the dialog box. QuickBooks will record the transaction.

 
To apply the credit to an invoice, choose the Apply to an invoice option and click OK. The Apply Credit to Invoices window will appear. Place a check mark in the first column in the field to the left of the date for invoice number. Click Done to record the transaction.

Write Checks 

When you use the Write Checks feature to record transactions, the Cash account is credited for the amount of the check. You select the account to be debited in the Account field in the window. To learn to use the Write Checks feature, review the steps below to enter a transaction. (May 1 Paid cash to Retail Properties for rent, $1,400.00. C344.) 

1.
From the Banking menu, choose Write Checks. The Write Checks – Cash window will appear as shown in Figure 39.

Figure 39 Write Checks – Cash Window 
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2.
If Cash does not show in the Bank Account field, select it from the drop-down list. Make sure Online Payment and To be printed are not selected (there is not a check mark in either box). Both of these boxes must be unchecked so you can enter the check numbers used in the transactions. If the To be printed option is selected, QuickBooks will automatically assign a check number. 

3.
Enter the check number in the No. field. Enter the date in the Date field. Enter the check amount in the $ field. Choose the name of the payee from the Pay to the order of drop-down list. QuickBooks enters the amount of the check on the Dollars line and the name and address in the Address box. 

4.
Click in the Account field. Select an account (such as Rent Expense) from the Account drop-down list. Key the check number (C344) in the Memo field. Review the transaction. Make changes if needed. Click the Save & New button (lower right corner of the Cash window) to save the transaction. 

5.
For transactions involving more than one account, such as the reimbursement of petty cash, enter each amount on a separate line. Use the same check number in the Memo field for all amounts in the transaction. 

6.
Repeat the process for all remaining cash payments. When you finish the last cash transaction, close the window by clicking the Save & Close button.

Apply a Credit Memo 

When you create a credit memo in QuickBooks, the software asks you what you would like to do with the credit memo. When you click Save & New in the Create Credit Memos/Refunds window for the May 3 transaction (Granted credit to Slippery Rock Inn for merchandise returned, $235.00, plus sales tax, $18.80, from S493; total, $253.80. CM67.), the Available Credit dialog box appears as in figure 40.

Figure 40 Available Credit Box 
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1.
Click the radio button next to Apply to an invoice as shown in Figure 41. S493 ($2,406.89 of merchandise, plus sales tax of $192.55, total $2,599.44.) has not yet been paid by Slippery Rock Inn. Click OK.

2.
The Apply Credit to Invoices window should appear as in Figure 41 below. Click in the column to the left of Date next to the invoice to which you wish to apply the credit (493 in this case). A check mark should appear next to the invoice. 

Figure 41 Apply Credit to Invoices Window 

[image: image41.png]Apply Credit o Invoices X

Cred Memo
Customer:Job  Sippery RockInn

Ref. o, &7 Original At 253,80
Date 05/03(2009 Remaining Credit 0.0

o Date b Number Orig. Amt. At Dus it Appled
iz @

Totds__ 2599.44 0.00 253.60

Clear Selections





3.
Click Done to apply the credit.

Print a Customer Balance Summary Report 

1.
Select Customers &Receivables from the Reports menu. Select Customer Balance Summary. 

2.
Enter or select May 1, YYYY and May 31, 2009 for the From and To dates. Click the Refresh button. The report data will appear as shown in Figure 42.

Figure 42 Customer Balance Summary Report 
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3.
Click the Modify Report button. The Modify Report dialog box will appear. Choose the Header/Footer tab. Key your name and the problem number in the Extra Footer Line text box. Click OK to save the footer.

4.
Click the Print button. The Print Reports dialog box will appear. Select the printer you wish to use. Select Portrait in the Orientation section. Click the Print button. 

5. Click the Close button on the report window to close the report.

Print a Vendor Balance Summary Report 

1.
Select Vendors & Payables from the Reports menu. Choose Vendor Balance Summary.
2.
Enter or select May 1, YYYY and May 31, 2009 for the From and To dates. Click the Refresh button. The report data will appear as shown in Figure 43.

Figure 43 Vendor Balance Summary Report  
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3.
Click the Modify Report button. The Modify Report dialog box will appear. Choose the Header/Footer tab. Key your name and the problem number in the Extra Footer Line text box. Click OK to save the footer.

4.
Click the Print button. The Print Reports dialog box will appear. Select the printer you wish to use. Select Portrait in the Orientation section. Click the Print button. 

5.
Click the Close button on the report window to close the report.

Print a Vendor Balance Detail Report 

1.
Choose Vendors and Payables from the Reports menu. Choose Vendor Balance Detail. A partial Vendor Balance Detail report is shown in Figure 44.
2.
Select the dates. Click the Refresh button. 

3.
Change the column widths to display all of the data. Add a custom footer that includes your name and the problem number. (See Step 5 under Journal Report.)

4.
Print the report in portrait orientation. (See Steps 6 through 9 under Journal Report.)

Figure 44 Vendor Balance Detail Report 
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5.
Click the Close button to close the report window.

Make Deposits 

When you use the Make Deposits feature, you choose the account to be debited in the Deposit To field in the window. You choose the account to be credited in the From Account field of the window. 

To learn to use the Make Deposits feature, follow the steps below to deposit Check 623 for $1,426.65 into the Payroll Account.

1.
From the Banking menu, choose Make Deposits. The Make Deposits window will appear as shown in Figure 45. (Close the QuickBooks Setting Default Accounts box if it appears.) 

Figure 45 Make Payroll Deposit 
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2.
In the Deposit To field, choose Payroll Account from the drop-down list. Enter May 15, YYYY in the Date field and Deposit in the Memo field.

3.
Click in the Received From field. Click the down arrow and choose Regular Account from the drop-down list. 

4.
Click in the From Account field. Click the down arrow and choose 1100 Cash from the drop-down list. Enter Deposit in the Memo field. Key the check number (623) in the Chk. No. field. 

5.
Click in the Pmt. Meth. field. Click the down arrow and choose Check from the drop-down list. In the Amount field, key the amount of the check (1426.65). This amount is the total net pay for the pay period ending May 15, 2009.

6.
Review the transaction. Make changes if needed. Click the Save & New button (lower right corner of the Make Deposits window) to save the transaction. 

Write Payroll Checks 

When you use the Write Checks feature, you choose the account to be credited in the Bank Account field in the window. You choose the account(s) to be debited and credited in the Account field in the window.

To learn to use the Write Checks feature to create payroll checks, follow the steps below to create a check for Wanda M. Curtis for the pay period ending May 15, YYYY.

1.
From the Banking menu choose Write Checks. Select Payroll Account in the Bank Account field. (Close the QuickBooks Setting Default Accounts box if it appears.)

2.
Enter 823 in the No. field and enter May 15, YYYY in the Date field.

3.
From the Pay to the order of drop-down list choose Wanda M. Curtis. Enter 652.33 in the $ field. Click in the Address field to refresh the check
4.
Click in the Account field on the Expenses tab. Click the down arrow and select Hourly Payroll Expense from the drop-down list. Enter 740.00 in the Amount field and C823 in the Memo field.

Figure 46 Wanda M. Curtis Payroll Check 
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5. 
Repeat the process on the next lines until you have entered all of the earnings and deduction information for Wanda M. Curtis. Be sure to enter the deduction amounts as negative numbers (-33.00 for Federal Income Tax Payable). Do not enter the Net Pay amount. You have entered that amount on the check.

6.
Make corrections if needed. Click Save & New to record the check.

7.
 Use the same steps to prepare Check 824 for Kevin R. Hayes. Remember to enter the Savings Bonds Payable deduction on his check. Click Save & Close when you are finished.

Write Off Customer Invoices 
In your accounting textbook, you are taught that uncollectible customer invoices should be written off to an account called Allowance for Uncollectible Accounts. The Allowance for Uncollectible Accounts is adjusted at the end of each fiscal period by making an adjusting entry to credit Allowance for Uncollectible Accounts and debit Uncollectible Accounts Expense.

QuickBooks users are expected to write off customer invoices directly to Uncollectible Accounts Expense. It is important to use the features in QuickBooks because they provide a customer history and an audit trail for transactions. Use the Create Credit Memos/Refunds window to charge customer invoices to Uncollectible Accounts Expense. Then use the Make General Journal Entries window to move the amount to the Allowance for Uncollectible Accounts.

To learn to record customer returns, review the steps below.  (September 5 Wrote off Jackson Company’s past-due account as uncollectible, $124.00. M234.)
1.
Choose Create Credit Memos/Refunds from the Customers menu. The Create Credit Memos/Refunds window will appear as in Figure 47.

Figure 47 Create Credit Memos/Refunds Window 
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2.
Choose Jackson Company from the Customer Job drop-down list. Choose September 7, YYYY for the date. Enter 1 in the Credit No. field. Enter the memorandum number M234 in the P.O. No. field.

3.
Click in the Item field. Click the arrow and choose Write-off from the drop down list. Key 124.00 in the Rate field. Click in the Amount field. No sales tax amount should be calculated.

4.
Click the Save & New button to save the transaction.

5.
The Available Credit dialog box should appear as shown in Figure 48.

Figure 48 Available Credit Dialog Box
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6.
Select the radio button next to Apply to an invoice. Click OK to close the dialog box. The Apply Credit to Invoices dialog box should appear as in Figure 49 below.

Figure 49 Apply Credit to Invoices Dialog Box 
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7.
Make sure there is a check mark in the field to the left of the date for invoice. Click Done. QuickBooks will record the transaction.

8.
Each time you process a credit memo to write off a customer invoice, make a journal entry (use the Make General Journal Entries window) to credit Uncollectible Accounts Expense and debit Allowance for Uncollectible Accounts for the amount of the write-off. Key the document number in the Memo field.

9.
Repeat the process for all remaining customer write-offs. When you have entered all of the write-off transactions, close the window by clicking the Save and Close button (lower right corner of the Create Credit Memos/Refunds window).

View a Customer Balance Detail Report

The Customer Balance Detail report shows all transactions for each customer account for the time period requested. The report can be run to include any period of time for which QuickBooks has data. 

1.
To view a Customer Balance Detail report, click Reports on the menu bar. Choose the Customers & Receivables option. Select Customer Balance Detail. The Customer Balance Detail window should appear as shown in Figure 50.
Figure 50 Customer Balance Detail Window 
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2.
Choose January 1, YYYY and September 30, YYYY as the From and To dates. Click the Refresh button. Change column widths as needed to display all of the data. 

3.
Add a footer that includes your name and the problem number. Print the report in portrait orientation.

Fixed Asset Item List 

The Fixed Asset Item feature can be used to track the cost of fixed assets and their depreciation from year to year. Complete the following steps to create an Item for each fixed asset in purchase transactions.

1.
Select Fixed Asset Item List from the Lists menu. Click the Item button near the bottom of the window and select New from the menu. The New Item window will appear as shown in Figure 51.

Figure 51 New Item Window 
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2.
Enter a name (Office Desk) for the asset in the Asset Name/Number field.

3.
Select an asset account (Office Equipment) from the Asset Account list.

4. 
Under Purchase Description, indicate whether the item is new or used (new). Enter a brief description of the item (Work Master desk). 

5.
Select or enter the purchase date (January 4, YYYY). Enter the cost of the item (700.00). Enter the vendor name (Jones Office Equipment).

6.
Enter an asset description (Work Master desk). Enter a serial number (WMD2009126). Click OK to save the item.

7. 
The item will appear in the Fixed Asset Item List as shown in Figure 52. When all new items are recorded, click the Close button to close the window.

Figure 52 Fixed Asset Item List 
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Edit a Fixed Asset Item 

Whenever a fixed asset is discarded, sold, or traded, the fixed asset item should be updated. One reason to make sure that the records are updated is to avoid paying property tax on assets that have been disposed. Taxing authorities generally use the fixed asset records of a company as a basis for determining the assessed value of taxable property.

Follow the steps learn how to edit a fixed asset item. (January 2, YYYY Discarded desk, serial no. D3481, plant asset no. 167, M47. The item is fully depreciated).
1.
Select Fixed Asset Item List from the Lists menu. Click the Item button near the bottom of the window and select Edit from the menu. The Edit Item window will appear as shown in Figure 53.
2.
Click the Item is sold box. Use this option for any fixed asset that is discarded, sold, or traded. 

Figure 53 Edit Item Window 
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3.
Click the Item is inactive box. This will remove the asset from any reports that are printed.

4.
Enter Desk—Discarded in the Sales Description field. If the asset is sold, enter --Sold. If the asset is traded, enter --Traded.
5.
Select or enter the Sales date (January 2, YYYY). Enter 0.00 in the Sales Price and Sales Expense fields. If the asset is sold or traded, enter the sales price or the trade in value in the Sales Price field. 

6.
Click OK to save the item. 

Fixed Asset Listing Report 

You can create a report showing the fixed assets items you have entered. Follow the steps below to create the report:

1. 
Select Fixed Asset Item List from the Lists menu to open the list. 

2.
Click the Reports button near the bottom of the Fixed Asset Items List window. Select Fixed Asset Listing from the menu.

3.
Adjust column widths to display all of the data. 

4.
Click the Modify Report button. On the Header/Footer tab, change the text in the Report Subtitle field to the appropriate date. Add a custom footer that includes your name and the problem number in the Extra Footer Line text box.


5.
Your report should look similar to Figure 54. No data will be displayed in the FAM Number column. FAM stands for Fixed Asset Manager. Fixed Asset Manager is a feature available in the QuickBooks Accountant edition software. When a company file is used with QuickBooks Accountant edition, a FAM number will be assigned to each item. 

Figure 54 Fixed Asset Listing Report 
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6.
Print the report in landscape orientation. 
Click the Close button to close the report. 

Purchase of Inventory 

In previous problems, material purchases were journalized to the Purchases account. The purchases were for total dollar amounts of “material”. No names or numbers were used to identify specific parts or products.


You can create individual inventory items (part numbers) in QuickBooks. When inventory items are used, an item is usually created for each part or product purchased into inventory.

When inventory items are used, QuickBooks records purchases as an increase in the Inventory account. (The Purchases account is not debited as it is when inventory items are not used.) Purchases of parts or products are recorded as a debit to Inventory. 

Review the steps below to learn to record an inventory purchase. (January 6 Purchased 20 units of P-234 from Master Electronics for $5.12 each; total $102.40. P154.)

1.
Choose the Enter Bills option from the Vendors menu. The Enter Bills window will appear. The Bill and Bill Received options near the top of the window should be checked. If they are not, check these options.
2.
Choose January 6, YYYY for the date. Choose Master Electronics from the Vendor drop-down list. Leave 0.00 in the Amount Due field. Enter the document number P154 in the Ref. No. field.

Figure 55 Enter Bills Window 
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3.
Click the Items tab. Click in the Item field and choose P-234 from the drop-down list. Electronic Switch will appear in the Description field and $4.98 will appear in the Cost field. The amount that appears in the Cost field is the weighted average cost of inventory on hand as of January 1, YYYY.

4.
Enter 20 (the quantity purchased) in the Qty field. Enter 5.12 (the cost per unit) in the Cost field. Click in the Amount field. The amount should change to $102.40 (20 units times $5.12). If the Item’s Cost Changed dialog box appears, as in Figure 56, click Yes.
Figure 56 Item’s Cost Changed Dialog Box
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5.
Click the Save & New button to record the transaction. Repeat the process for all remaining purchases on account.

Sale of Inventory 

The Create Invoices feature is used to record merchandise sales on account. The customer’s Accounts Receivable account is debited. The Sales account is credited for the selling price of the merchandise. The inventory value (cost) of parts or products that are sold is credited to Inventory and debited to Purchases (a Cost of Goods Sold account). Use of inventory items allows QuickBooks to track changes in inventory and provide on-hand balance information. Accurate on-hand balance information can prevent a shortage or excess of specific parts.

The use of inventory items on sales invoices provides the customer with more detailed information about each purchase. The detailed information also makes it possible to track which customers buy particular inventory items.

Review the steps below to learn to record a sales transaction. (April 5 Sold 22 of P-234 to Evans Construction on account; S1998, $218.90, no tax.) 

1.
Select Create Invoices from the Customers menu. The Create Invoices window will appear as shown in Figure 57.

2.
Choose the Intuit Product Invoice template from the drop down list. Choose Evans Construction from the Customer Job drop-down list. Enter April 5, 2009 in the Date field. Enter 1998 in the Invoice # field.

3.
Enter 22 (the quantity Sold) in the Quantity field. Click in the Item Code field and choose P-234 from the drop-down list. Electronic Switch will appear in the Description field, 9.95 will appear in the Price Each field, and 218.90 will appear in the Amount field. 

Figure 57 Create Invoices Window 
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4.
Click the Save & New button to record the transaction. Repeat the process for all remaining sales on account transactions.

Inventory Valuation Detail Report 

Review the steps below to learn to create an Inventory Valuation Detail report. 

1.
Choose Inventory from the Reports menu. Select Inventory Valuation Detail. 

2.
Select January 1, YYYY and December 31, YYYY for the dates. Adjust the column widths to display all of the data. Add a custom footer that includes your name and the problem number. Print the report in landscape orientation.

3.
Click the Close button to close the report.

Record Notes Payable 

In general, a note payable may be signed for one of two reasons. The first reason to sign a note payable is in exchange for a specific asset, such as cash. The second reason to sign a note payable is to extend the time required for payment of purchases on account.

Note Payable for Cash 

Use the Make Deposits option to record a debit to Cash for the principal value of the note payable and a credit to Notes Payable. Review the steps below to learn to record a transaction. (April 6, YYYY Signed a 180-day, 12% note for $10,000.00 with First American Bank. R127).
1.
Select Make Deposits from the Banking menu. The Make Deposits window will appear as shown in Figure 58.
Figure 58 Make Deposits Window 
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2.
Choose Cash from the Deposit To drop-down list. Select a date (April 6, 2009). Deposit will appear automatically in the Memo field.
3.
Click in the first line of the Received From field. Click the down arrow and choose First American Bank from the drop-down list.

4.
Click in the first line of the From Account field. Click the down arrow and choose Notes Payable from the drop-down list. Enter Deposit in the Memo column.

5.
Enter the source document number (R127) in the Chk. No. field. Click in the first line of the Pmt. Meth. field. Click the down arrow and choose Cash from the drop-down list. Enter the principal amount of the note (10,000.00) in the Amount field.

6.
Click the Save and New button to save the transaction. Repeat the process for all similar transactions.

7.
Click Save & Close to close the Make Deposits window when you are finished recording transactions.
Note Payable to Extend Payment Terms 

A company may sign a note payable to extend the time required for payment for purchases on account. In this case, use the Enter Bills option from the Vendors menu to debit Accounts Payable and credit Notes Payable for the amount owed (principal value of the note). 

Follow the steps below to record the April 12 transaction. (Signed a 60-day, 9% note with Milligan Company for an extension of time on this account payable, $600.00. M32.).

1.
Choose the Enter Bills option from the Vendors menu. The Enter Bills window will appear as shown in Figure 59.

Figure 59 Enter Bills Window
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2.
Select the Credit option. Select Milligan Company from the Vendor drop-down list. Select April 12, YYYY for the date.

3.
Enter 600.00 in the Credit Amount field. Enter the source document number (M32) in the Ref. No. field.

4.
Click in the first line of the Account field. Click the down arrow and choose Notes Payable from the drop-down list. Key M32 in the Memo field.

5.
Cick the Save and New button to save the transaction. Repeat the process for all similar transactions.

6.
Click Save & Close to close the Enter Bills window when you are finished recording transactions.

Record Notes Receivable 
In general, a note receivable may be accepted for one of two reasons. The first reason to accept a note receivable is to extend the time required for payment of purchases on account by customers. The second reason to accept a note receivable is in exchange for specific assets, such as in a sale of merchandise.

Notes Receivable to Extend Payment Terms 

Notes receivable are signed by customers to extend the payment terms for a previous purchase on account. When a note receivable is signed by a customer, use the Receive Payments option from the Customers menu to record a debit to Notes Receivable and a credit to the customer’s Accounts Receivable account.
Review the steps below to learn to record a transaction. (July 7 Accepted a 90-day, 10% note from Nan Albert for an extension of time on her account, $1,500.00. NR9.).

1.
Choose the Receive Payments option from the Customers menu. The Received Payments window will appear as shown in Figure 60.

Figure 60 Receive Payments Window 
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2.
Choose Nan Albert from the Received From drop-down list. Select July 7, YYYY for the date.

3.
Enter 1,500.00 in the Amount field. Choose Cash from the Pmt. Method drop-down list. Enter NR9 in the Reference No. field. Enter Converted to Note Receivable in the Memo field.

4.
Click in the field to the left of the date to place a checkmark next to the invoice. Select the Deposit To option and choose Notes Receivable from the drop-down list.

5.
Click the Save & New button to record the transaction. Repeat the process for all similar transactions.

Notes Receivable for Sales on Account

Most sales on account assume that the customer will pay within 30 days. To promote sales, a company may allow a customer to sign a note receivable extending the payment over a longer period. The following transaction is an example of this situation. (August 1 Accepted a 60-day, 12% note from Frank Otto for a sale on account, $300.00. NR2.)

Use the Make General Journal Entries window to record this type of transaction as described in the steps below. 

1.
Choose Make General Journal Entries from the Company menu. 

2.
Debit Notes Receivable for the principal value of the note. Enter the document number in the Memo field. Select the customer’s name from the Name field as shown in Figure 61.
Figure 61 Note Receivable for Sale on Account
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3.
Credit Sales for the principal value of the note. Enter the document number in the Memo field.

4. Click the Save & New button to save the transaction.

Record Cash from Notes Receivable 
Use the Make Deposits option to record the cash received from customer payment of the maturity value of a note receivable. Cash will be debited. Notes Receivable and Interest Income will be credited. Review the steps below to learn to record a transaction. (July 9 Received cash for the maturity value of NR4, a 60-day, 9% note for $1,600.00. R62.)
1.
Select Make Deposits from the Banking menu. The Make Deposits window will appear as shown in Figure 62.

Figure 62 Make Deposit for Cash from Note Receivable 

[image: image62.png]Make Deposits.
rrevos B rex G - B payments U Hstory

Deposit To (1105 Cash v | Dete [07/03/2009 (8] Memo [Deposit

Clck Payments to slect customer payments that you have received. List any other amounts to depost below.

Received From From Account Wema, Chkio, | P freth
1115 - Notes Receivable [peposic rez 1,600.00 A
7110  Interest Income Ipeposic ez 24.00

Depast: Subtatal 1,624.00

o get cash back from this depost, enter the amount below, Indicate the account
‘where you wan tis money to go, such as your Petty Cash account:

Cash back gossto Cash back memo Cash back amaunt

Depast Total 1,624.00

Syl T Saesce





2.
Choose Cash from the Deposit To drop-down list. Select July 9, YYYY for the date. Deposit will appear automatically in the Memo field.
3.
Leave the Received From field blank. Click in the first line of the From Account field. Click the down arrow and choose Notes Receivable from the drop-down list. Enter Deposit in the Memo column.

5.
Enter the source document number (R62) in the Chk. No. field. Click in the first line of the Pmt. Meth. field. Click the down arrow and choose Cash from the drop-down list. Enter the principal amount of the note (1,600.00) in the Amount field.

6.
In the second line of the From Account field, select Interest Income from the drop-down list. Enter Deposit in the Memo column. Enter the source document number (R62) in the Chk. No. field. In the Pmt. Meth. field, choose Cash from the drop-down list. 

7.
The amount stated in the transaction is the principal amount of the note (1,600.00). You must manually calculate the interest amount for the note. After calculating the interest amount, enter the interest amount (24.00) in the Amount field.

8.
Click the Save and New button to save the transaction. Repeat the process for all similar transactions.

Account Classes 

When account classes are used in QuickBooks, reports can created that show items by class. An account class can be used to separate accounting data by department, territory, product, or any other item that can be traced to a general ledger account or accounts. Only one account class can be assigned to each general ledger account. The same account class can be used for several general ledger accounts.

To learn to use account classes, review an adjusting entry for Allowance for Uncollectible Accounts.

1.
Open the Make General Journal Entries window from the Company menu as shown in Figure 63. 

Figure 63 Make General Journal Entries Window 
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2.
Select December 31, YYYY in the Date field. Key 1 in the Entry No. field.

3.
For the first line of the entry, choose Uncollectible Accounts Expense from the drop-down list in the Account field. Key the amount (1,457.00) in the Debit field. Key Adjusting in the Memo field and choose General from the drop-down list in the Class field.

4.
Repeat the process for the credit to Allowance for Uncollectible Accounts. Remember to choose Uncollectible from the drop-down list in the Name field. Click Save & New to record the adjusting entry.

5.
Repeat the process for all remaining adjusting entries. Remember to choose the correct class for all accounts. When you have finished making general journal entries, click Save & Close to close the window.
Profit & Loss by Class Report

Review the steps below to learn to prepare a Profit & Loss by Class report that includes component percentages for expenses and net loss.


1.
From the Reports menu, choose Company & Financial. Choose Profit & Loss by Class. Select January 1, YYYY and December 31, YYYY for the From and To dates. Click the Refresh button.

2.
To add component percentages, click the Modify Report button. The Modify Report: Profit & Loss dialog box will appear. In the Columns section on the Display tab, click the box next to % of Income. A check should appear in the box as shown in Figure 64. 

Figure 64 Modify Report Display Tab 
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3.
Click the Header/Footer tab. Enter your name and the problem number in the Extra Footer Line box. Click OK to close the dialog box.

4.
Click the Print button in the Profit & Loss window. Select the printer you wish to use in the Print Reports dialog box. Select portrait orientation and click the Print button.

5.
Click the Close button to close the report.

Budget vs. Actual Report 

Follow the steps below to prepare a Budget vs. Actual report that includes component percentages for income, expenses, and net loss or income.

1.
From the Reports menu, choose Budgets. Select Budget vs. Actual. The Budget Report wizard will appear as shown in Figure 65.

Figure 65 Select a Budget  
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2.
Select FY2009 – Profit & Loss by Account from the list if it does not already appear. Click Next. 

3. 
Select Account by Month from the list as shown in Figure 66. Click Next. Click Finish. 

Figure 66 Select a Budget Layout 
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4.
The report will appear on screen. Select January 1, YYYY and March 31, YYYY for the dates. Select Quarter from the Columns list (at the top of the screen near the dates). Click the Refresh button. The top portion of a sample report is shown in Figure 67.

Figure 67 Profit & Loss Budget vs. Actual Report 
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5.
Review the report. The heading contains the company name, the type of report, and the report dates. The report columns contain the budget and actual data.

· The first column contains account categories and account names. 

· The second column shows the actual amounts for January through March, YYYY. 

· The third column contains the budgeted amounts for the same time. 

· The fourth column shows amounts over or under budget. The column is titled $ Over Budget; therefore, positive numbers in this columns are amounts over budget. Negative numbers in this column are amounts under budget. 

· The fifth column shows the percentage each actual amount is of the budgeted amount. For example, the actual Sales amount is 103% of the budgeted amount, an unfavorable difference of 3%.

6.
Click the Modify Report button. Click the Header/Footer tab. Enter your name and the problem number in the Extra Footer Line box. Click OK to close the dialog box.

7.
Print the report in portrait orientation.

8.
Click the Close button to close the report.

Profit & Loss Previous Year Comparison Report 

Follow the steps below to prepare a Profit & Loss Previous Year Comparison report. 

1.
From the Reports menu, choose Company & Financial. Choose Profit & Loss Prev Year Comparison. Select January 1, YYYY and December 31, YYYY for the From and To dates. Click the Refresh button. The top portion of a sample report is shown in Figure 68.
Figure 68 Profit & Loss Previous Year Comparison Report 
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2.
Review the report. Note that Column 4 shows the dollar amount of change from the previous year. Column 5 shows the percent of change from the previous year.

3.
Click the Modify Report button. Click the Header/Footer tab. Enter your name and the problem number in the Extra Footer Line box. Click OK to close the dialog box.

4.
Print the report in portrait orientation. Click the Close button to close the report.

Balance Sheet Previous Year Comparison Report 


Follow the steps below to prepare a Balance Sheet Previous Year Comparison report. 

1.
From the Reports menu, choose Company & Financial. Choose Balance Sheet Prev Year Comparison. Select December 31, YYYY for the date. Click the Refresh button. The top portion of a sample report is shown in Figure 69.

Figure 69 Balance Sheet Previous Year Comparison Report 
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2.
Review the report. Note that Column 4 shows the dollar amount of change from the previous year. Column 5 shows the percent of change from the previous year.

3.
Click the Modify Report button. Click the Header/Footer tab. Enter your name and the problem number in the Extra Footer Line box. Click OK to close the dialog box.

4.
Print the report in portrait orientation. Click the Close button to close the report.

Statement of Cash Flows Report 
QuickBooks automatically sets up the Statement of Cash Flows report format from the balance sheet accounts in the chart of accounts. Individual accounts are assigned to Adjustments to Net Income, Investing Activities, or Financing Activities based on QuickBooks defaults. Account assignments can be changed in the QuickBooks Preferences window. 

Follow the steps below to prepare a Statement of Cash Flows report.


1.
From the Reports menu, choose Company & Financial. Choose Statement of Cash Flows. 

2.
Select January 1, YYYY and December 31, YYYY for the dates. Click the Refresh button. The top portion of a sample report appears in Figure 70.

3.
Click the Modify Report button. Click the Header/Footer tab. Enter your name and the problem number in the Extra Footer Line box. Click OK to close the dialog box.

Figure 70 Statement of Cash Flows Report for YYYY
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4.
Adjust column widths to display all of the data. Print the report in portrait orientation.

5.
Click the Close button to close the report.

Add New Accounts 

As new situations arise, accounting employees add new accounts to the chart of accounts to accumulate accounting data. Review the steps below to learn to add new equity accounts to the chart of accounts.

1.
Choose Chart of Accounts from the Lists menu. Click the Account button at the bottom of the Chart of Accounts window and choose New from the menu. The New Account window will appear as shown in Figure 71.

2.
In the New Account window, choose Equity from the Type drop-down list.

Figure 71 New Account Dialog Box 
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3.
Key Frank Boyd, Capital in the Name box. Key the account number (3135) in the Number box. Click OK to add the account.

4.
Repeat the process to add the other accounts.

5.
View the Chart of Accounts window to make sure your data is correct. If you need to make a correction, click the Account button. Choose Edit Account from the menu, key the changes, and click OK. The changes will show on the Chart of Accounts window.

Receive Units from Production 

QuickBooks does not have the capability to track manufacturing costs for inventory costing purposes. However, inventory items can be tracked by using the Inventory Activities feature. Changes to both the value and on-hand quantity can be journalized using the Adjust Quantity/Value on Hand window. QuickBooks records a journal entry debiting Finished Goods and crediting Work in Process for the amount of the adjustment.

Follow the steps below to record a transaction. (April 2, YYYY Production completed 210 C45 bats and sent them to finished goods inventory. The unit cost was $8.80; total $1,848.00. Job No. 315).

1.
From the Vendors menu choose Inventory Activities. Select Adjust Quantity/Value on Hand. The Adjust Quantity/Value on Hand window will appear. If there were additional inventory items, they would appear in the window.

2.
Select April 2, YYYY in the Adjustment Date field. Enter the job number (Job 315) in the Ref. No. field.

3.
Choose 1130 Work in Process from the Adjustment Account drop-down list. If the Income or Expense Expected message box appears, click the Close button. Leave the Customer: Job field blank.
4.
Select (check) the Value Adjustment option near the bottom of the window. The New Value field will appear on the right side of the window as shown in Figure 72. 
Figure 72 Adjust Quantity/Value on Hand Window 
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5.
Enter 490 in the New Qty column. (This amount is the beginning on-hand balance of 280 units plus the 210 units received from production).

6.
Delete the amount (4,263.00) shown in the New Value field. Enter 4,284.00 in the New Value field. (This amount is 280 units @ $8.70 plus 210 units @ $8.80).

7.
Click Save & New to save the transaction. QuickBooks will record a journal entry debiting Finished Goods and crediting Work in Process for the amount of the adjustment ($1,848.00).

8.
When all receipt transactions have been recorded, click Save & Close to close the window.

Software Tip


To change the date:


1.	Click the calendar button. 


       �





2.	Click the left or right arrow to find the month.





�





3.	Click the date for your journal entry.





Software Tip


All of the reports you need can be accessed by clicking Reports on the Menu bar and choosing an option from the drop-down list.








Accounting Tip 


The Statement Date in the Begin Reconciliation dialog box should be the date you prepare the reconciliation—not the date on the bank statement.
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Software Tip


You can also print the report by clicking the Print button on the Print Preview screen. 
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Accounting Tip 


The beginning balance on the bank statement might not equal the beginning balance in the Begin Reconciliation dialog box. If this is the case, make sure you made any adjustments needed after the prior month’s reconciliation.





Software Tip


QuickBooks allows you to create reports on both the cash and accrual basis. For the problems in this book, you will report on the accrual basis. Make sure that Accrual is selected under Report Basis as shown in Figure 20





Software Tip 


If you do not use the QuickBooks Write Checks feature, the Entry No. will show in the Chk # field. Review the Journal report to find the check number for each transaction.





Accounting Tip 


If you find a discrepancy, do not assume that the bank statement is correct. Checks can be processed for an incorrect amount. Deposits can be put in an incorrect account. 





Software Tip 


You can choose to display your report as a PDF file. You must have Adobe Acrobat or Acrobat Reader loaded on your computer to view the report in PDF format.





Software Tip


Remember to choose Uncollectible from the Name drop down list when you make a journal entry to Allowance for Uncollectible Accounts.
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Accounting Tip


Eliminating non-zero rows makes reports easier to read.
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Software Tip


Use the Enter Bills feature to record all purchases on account—not just purchases of merchandise inventory.





Software Tip


You can leave the Make General Journal Entries, Enter Bills, and Pay Bills windows open while working this problem. To move between windows, click the name of the desired window in the Open Windows box on the left side of the QuickBooks main window.
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Software Tip


The list may show more than one bill to be paid on the date you selected. You must put a check mark next to each bill to be paid.





Software Tip


Always check the Payment Date field. The date in this field is what shows on the Journal report.





Software Tip


The list may show more than one bill. You must assign a check number to each item. You can assign the same check number to multiple items from the same vendor.





Accounting Tip


A major goal of businesses is to control cash (prevent theft). One procedure used to control cash is to have one person enter the bills and a different person create the checks.





Software Tip


Choose the Credit option to enter a credit for an invoice that has already been paid. Do not use the Credit option for an unpaid invoice. This will cause QuickBooks to calculate the vendor discount incorrectly.





QuickBooks Help


bills from vendors


reports about


Unpaid Bills Detail report





Software Tip


If a warning box appears, click OK to close the box.
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Software Tip


QuickBooks automatically applies customer payments. If more than one invoice shows for the company, QuickBooks applies the payment to the oldest invoice first.





Software Tip


The underpayment warning box alerts you when the customer payment does not equal customer balance. You must decide to apply a discount, leave the amount as an underpayment, or write off the amount.
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Software Tip


The Bill To, Ship To, and Terms data are entered in the Customer: Job List. The Via (shipment method) and F.O.B. (Free On Board) data is part of the QuickBooks Preferences.
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Software Tip


For QuickBooks to calculate sales tax correctly, the nontaxable portion of sales receipts should be entered on a separate line in the Enter Sales Receipts window.





Software Tip


The Create Credit Memos/Refunds window can also used to correct billing errors. You will learn about this in a later problem.





Software Tip


If the invoice to which the credit applies is unpaid, choose the Apply to an invoice radio button. If the customer requests a refund, choose the Give a refund radio button. Click OK to close the dialog box. 
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Software Tip 


You will use the Write Checks window only to enter transactions. If you had the proper forms, you could also print the checks from this window using the Print button.





Accounting Tip


GAAP stands for generally accepted accounting principles.





Software Tip


Make sure there is not a check mark in either the Online Payment or To be printed box. Both of these boxes must be unchecked so you can enter the check numbers used in the transactions.
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Software Tip


Using the Fixed Asset Manager in QuickBooks Accountant software, an accountant can determine depreciation for an asset. A journal entry is posted to the company file to record the depreciation. 





Software Tip


Be sure to use the correct date and document number when entering transactions.





Software Tip


QuickBooks pulls the price each from the Item List and calculates the amount by multiplying the quantity sold by the price each.





Software Tip


Journal entries to Accounts Receivable, Allowance for Uncollectible Accounts, and Accounts Payable require a customer or vendor name in the Name field.
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Software Tip


QuickBooks allows you to create reports on both the cash and accrual basis. For the problems in this book, you will report on the accrual basis. Make sure that Accrual is selected under Report Basis as shown in Figure 62.
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Check Figure


The Net Income % of Budget total on the Profit & Loss Budget vs. Actual report should be 103.5%.
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profit and loss


profit & loss prev year comparison report
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balance sheet prev year comparison report
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statement of cash flows report
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